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Disclaimer 0
Dimensional Insight, Inc. disclaims the implied warranties of merchantability and fitness for a particular purpose and 
makes no express warranties except as may be stated in its written agreement with and for its customer.

In no event is Dimensional Insight liable to anyone for any indirect, special, or consequential damages. The 
information and specifications in this manual are subject to change without notice.

Copyright © Dimensional Insight, 1991-2014.

Trademarks 0
Microsoft®, Windows®, and Excel® are registered trademarks of Microsoft Corporation in the United States and 
other countries.

AIX®, AS/400®, and DB2® are registered trademarks and iSeries™ is a trademark of International Business 
Machines Corporation.

Adobe®, Acrobat®, and Distiller® are registered trademarks of Adobe Systems Incorporated.

Oracle® and Java® are registered trademarks of Oracle and/or its affiliates. Other names may be trademarks of their 
respective owners.

Google Maps™ is a trademark of Google Inc. Other product and company names mentioned in this manual are the 
service mark, trademark, or registered trademark of their respective owners.

Limited Warranty and Liability 0
Dimensional Insight, Inc. (DII) is the owner of the Software to which this documentation applies. The Software is 
subject to copyrights, patents and other intellectual property rights of DII, is furnished only under a license to use it, 
and no ownership rights are conveyed in the Software under any circumstances. License rights are set out in written 
license agreements entered into by all licensees either prior to delivery of the Software or prior to first use of the 
Software. No use of the Software is permitted unless the user has first agreed to the terms of the license. DO NOT USE 
THE SOFTWARE IF YOU HAVE NOT REVIEWED AND AGREED TO THE TERMS OF THE LICENSE.

THE SOFTWARE IS FURNISHED “AS IS” AND WITHOUT WARRANTY OF ANY KIND OR NATURE TO THE 
EXTENT PERMITTED BY APPLICABLE LAW. DII EXPRESSLY DISCLAIMS ALL WARRANTIES, EXPRESS, 
IMPLIED OR STATUTORY, INCLUDING THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS 
FOR PARTICULAR PURPOSE, SATISFACTORY QUALITY AND NONINFRINGEMENT, AND THEIR 
EQUIVALENTS UNDER ANY LAW OF ANY JURISDICTION. IF APPLICABLE LAW IMPLIES ANY 
WARRANTIES OR CONDITIONS WITH RESPECT TO THE SOFTWARE, ALL SUCH WARRANTIES OR 
CONDITIONS ARE LIMITED TO A PERIOD OF THIRTY (30) DAYS FROM THE DATE OF DELIVERY OF 
THE SOFTWARE TO THE LICENSEE.

DII DOES NOT WARRANT THAT THE FUNCTIONS CONTAINED IN THE SOFTWARE WILL MEET YOUR 
REQUIREMENTS, OR THAT THE OPERATION OF THE SOFTWARE WILL BE UNINTERRUPTED OR 
ERROR-FREE, OR THAT DEFECTS IN THE SOFTWARE WILL BE CORRECTED. FURTHERMORE, DII 
DOES NOT WARRANT OR MAKE ANY REPRESENTATIONS REGARDING THE USE OR THE RESULTS OF 
THE USE OF THE SOFTWARE IN TERMS OF THEIR CORRECTNESS, ACCURACY, RELIABILITY, OR 
OTHERWISE. SHOULD THE SOFTWARE PROVE DEFECTIVE, LICENSEE (AND NOT DII, ITS 
DISTRIBUTORS, DEALERS OR EMPLOYEES) WILL ASSUME THE ENTIRE COST OF ALL NECESSARY 
SERVICING, REPAIR, OR CORRECTION.
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SOME STATES AND JURISDICTIONS DO NOT ALLOW THE EXCLUSION OF EXPRESS OR IMPLIED 
WARRANTIES OR CONDITIONS UNDER CERTAIN CIRCUMSTANCES, SO THE ABOVE EXCLUSIONS 
MAY NOT APPLY TO YOU. IF SUCH EXCLUSIONS DO NOT APPLY TO YOU, AND ONLY IN SUCH EVENT, 
YOUR SOLE REMEDY WILL BE, AT DII’S OPTION, REPAIR OR REPLACEMENT OF THE SOFTWARE OR 
A REFUND OF THE PRICE PAID BY YOU FOR THE SOFTWARE. THIS WARRANTY GIVES YOU SPECIFIC 
LEGAL RIGHTS. YOU MAY ALSO HAVE OTHER LEGAL RIGHTS WHICH VARY FROM STATE TO STATE 
AND JURISDICTION TO JURISDICTION.

While efforts have been made to ensure THAT the program and its documentation are free from defects, under no 
circumstances and under no legal theory, whether tort, contract, or otherwise, shall DII, or its distributors, dealers or 
employees, be liable to you or any other person for any loss or damage sustained in connection with ANY ATTEMPT 
TO use the Software, including without limitation, any economic, consequential or other indirect loss or damage, even 
if DII has been previously advised of the possibility of such loss or damage. Some states and jurisdictions do not allow 
the exclusion or limitation of INCIDENTAL or consequential damages under certain circumstances, so this limitation 
and exclusion may not apply to you.

U.S. Export Administration Act: Restrictions on Exporting Software 0
The Software may include certain cryptographic software that may be subject to export controls under the U.S. Export 
Administration Act. The Software may not be exported to any country or to any foreign entity or “foreign person” to 
the extent prohibited under applicable U.S. government regulations. By downloading or using the Software, you are 
acknowledging and agreeing to the foregoing limitations on your right to export or re-export the Software, and are also 
representing and warranting that you are neither on any of the U.S. government’s lists of export precluded parties nor 
otherwise ineligible to receive software containing cryptography that is subject to export controls under the U.S. 
Export Administration Act.

If a version of DiveLine that uses encryption is running, administrators must be aware that allowing users outside the 
United States to access data via certain DI-Clients qualifies as exporting encryption software (either the client 
executable or the Java applet sent to the browser). Export or re-export of encrypted software must be in accordance 
with the Export Administration Regulations. Diversion of encryption software contrary to U.S. law is prohibited.

Third Party Licensing 0

OpenSSL Toolkit 0

The licensing below applies to the third party encryption library routines ONLY.

This product may include software developed by the OpenSSL Project for use in the OpenSSL Toolkit (http://
www.openssl.org/) [Copyright © 1998-2011 The OpenSSL Project. All rights reserved.]

This product may include cryptographic software written by Eric Young (eay@cryptsoft.com) [Copyright © 
1995-1998 Eric Young (eay@cryptsoft.com). All rights reserved.]

Below are the two licenses which cover the use of these routines.

  LICENSE ISSUES
  ==============

  The OpenSSL toolkit stays under a dual license, i.e. both the conditions of
  the OpenSSL License and the original SSLeay license apply to the toolkit.
  See below for the actual license texts. Actually both licenses are BSD-style
  Open Source licenses. In case of any license issues related to OpenSSL
  please contact openssl-core@openssl.org.

  OpenSSL License
  ---------------
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/* ====================================================================
 * Copyright (c) 1998-2005 The OpenSSL Project.  All rights reserved.
 *
 * Redistribution and use in source and binary forms, with or without
 * modification, are permitted provided that the following conditions
 * are met:
 *
 * 1. Redistributions of source code must retain the above copyright
 *    notice, this list of conditions and the following disclaimer.
 *
 * 2. Redistributions in binary form must reproduce the above copyright
 *    notice, this list of conditions and the following disclaimer in
 *    the documentation and/or other materials provided with the
 *    distribution.
 *
 * 3. All advertising materials mentioning features or use of this
 *    software must display the following acknowledgment:
 *    "This product includes software developed by the OpenSSL Project
 *    for use in the OpenSSL Toolkit. (http://www.openssl.org/)"
 *
 * 4. The names "OpenSSL Toolkit" and "OpenSSL Project" must not be used to
 *    endorse or promote products derived from this software without
 *    prior written permission. For written permission, please contact
 *    openssl-core@openssl.org.
 *
 * 5. Products derived from this software may not be called "OpenSSL"
 *    nor may "OpenSSL" appear in their names without prior written
 *    permission of the OpenSSL Project.
 *
 * 6. Redistributions of any form whatsoever must retain the following
 *    acknowledgment:
 *    "This product includes software developed by the OpenSSL Project
 *    for use in the OpenSSL Toolkit (http://www.openssl.org/)"
 *
 * THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT ``AS IS'' AND ANY
 * EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
 * IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
 * PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL THE OpenSSL PROJECT OR
 * ITS CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
 * SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT
 * NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;
 * LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
 * HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,
 * STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)
 * ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED
 * OF THE POSSIBILITY OF SUCH DAMAGE.
 * ====================================================================
 *
 * This product includes cryptographic software written by Eric Young
 * (eay@cryptsoft.com).  This product includes software written by Tim
 * Hudson (tjh@cryptsoft.com).
 *
 */
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 Original SSLeay License
 -----------------------

/* Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com)
 * All rights reserved.
 *
 * This package is an SSL implementation written
 * by Eric Young (eay@cryptsoft.com).
 * The implementation was written so as to conform with Netscapes SSL.
 *
 * This library is free for commercial and non-commercial use as long as
 * the following conditions are adhered to.  The following conditions
 * apply to all code found in this distribution, be it the RC4, RSA,
 * lhash, DES, etc., code; not just the SSL code.  The SSL documentation
 * included with this distribution is covered by the same copyright terms
 * except that the holder is Tim Hudson (tjh@cryptsoft.com).
 *
 * Copyright remains Eric Young's, and as such any Copyright notices in
 * the code are not to be removed.
 * If this package is used in a product, Eric Young should be given attribution
 * as the author of the parts of the library used.
 * This can be in the form of a textual message at program startup or
 * in documentation (online or textual) provided with the package.
 *
 * Redistribution and use in source and binary forms, with or without
 * modification, are permitted provided that the following conditions
 * are met:
 * 1. Redistributions of source code must retain the copyright
 *    notice, this list of conditions and the following disclaimer.
 * 2. Redistributions in binary form must reproduce the above copyright
 *    notice, this list of conditions and the following disclaimer in the
 *    documentation and/or other materials provided with the distribution.
 * 3. All advertising materials mentioning features or use of this software
 *    must display the following acknowledgement:
 *    "This product includes cryptographic software written by
 *     Eric Young (eay@cryptsoft.com)"
 *    The word 'cryptographic' can be left out if the routines from the library
 *    being used are not cryptographic related :-).
 * 4. If you include any Windows specific code (or a derivative thereof) from
 *    the apps directory (application code) you must include an acknowledgement:
 *    "This product includes software written by Tim Hudson (tjh@cryptsoft.com)"
 *
 * THIS SOFTWARE IS PROVIDED BY ERIC YOUNG ``AS IS'' AND
 * ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
 * IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE
 * ARE DISCLAIMED.  IN NO EVENT SHALL THE AUTHOR OR CONTRIBUTORS BE LIABLE
 * FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL
 * DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS
 * OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
 * HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
 * LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY
 * OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF
 * SUCH DAMAGE.
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 *
 * The licence and distribution terms for any publicly available version or
 * derivative of this code cannot be changed.  i.e. this code cannot simply be
 * copied and put under another distribution licence
 * [including the GNU Public Licence.]

Apache Libraries 0

DivePort, NetDiver, and DIAL use libraries covered under the license below.

   Licensed under the Apache License, Version 2.0 (the "License");
   you may not use this file except in compliance with the License.
   You may obtain a copy of the License at

       http://www.apache.org/licenses/LICENSE-2.0

   Unless required by applicable law or agreed to in writing, software
   distributed under the License is distributed on an "AS IS" BASIS,
   WITHOUT WARRANTIES OR CONDITIONS OF ANY KIND, either express or implied.
   See the License for the specific language governing permissions and
   limitations under the License.

Apache Commons Codec
Copyright 2002-2012 The Apache Software Foundation

Apache HttpComponents Client
Copyright 1999-2012 The Apache Software Foundation

Apache Commons Logging
Copyright 2003-2007 The Apache Software Foundation

Apache POI
Copyright 2009 The Apache Software Foundation

This product includes software developed by
The Apache Software Foundation (http://www.apache.org/).

This product contains the DOM4J library (http://www.dom4j.org).
Copyright 2001-2005 (C) MetaStuff, Ltd. All Rights Reserved.

This product contains parts that were originally based on software from BEA.
Copyright (c) 2000-2003, BEA Systems, <http://www.bea.com/>.

This product contains W3C XML Schema documents. Copyright 2001-2003 (c)
World Wide Web Consortium (Massachusetts Institute of Technology, European
Research Consortium for Informatics and Mathematics, Keio University)

This product contains the Piccolo XML Parser for Java
(http://piccolo.sourceforge.net/). Copyright 2002 Yuval Oren.

This product contains the chunks_parse_cmds.tbl file from the vsdump program.
Copyright (C) 2006-2007 Valek Filippov (frob@df.ru)
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Google Automated Error Reporting 0

This product includes portions of automated error reporting software which require the display of the following 
disclaimer. This disclaimer applies only to those portions of code, not to the product as a whole.

 Copyright (c) 2010, Google Inc.
 All rights reserved.

 Redistribution and use in source and binary forms, with or without
 modification, are permitted provided that the following conditions are
 met:

 * Redistributions of source code must retain the above copyright
   notice, this list of conditions and the following disclaimer.
 * Redistributions in binary form must reproduce the above
   copyright notice, this list of conditions and the following disclaimer
   in the documentation and/or other materials provided with the
   distribution.
 * Neither the name of Google Inc. nor the names of its
   contributors may be used to endorse or promote products derived from
   this software without specific prior written permission.

 THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS
 "AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
 LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR
 A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE COPYRIGHT
 OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
 SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
 LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE,
 DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY
 THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
 (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE
 OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.

Copyright © 2015 Dimensional Insight, Inc., 60 Mall Road, Burlington, MA 01803

(http://www.dimins.com)
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Chapter 1
Introduction 1

DI-Scheduler allows you as an administrator to automate tasks related to Dimensional Insight 
products, including building Models and running Data Integrator scripts. This program helps you 
manage jobs, events, and tasks, as well as allowing you to view their current status and history.

Using the DI-Scheduler Manual 1
This manual is separated into four chapters:

• Chapter 1, Introduction - contains an overview of the manual, a description of 
DI-Scheduler’s usage, a list of helpful terms, and installation and startup steps for the 
software.

• Chapter 2, The DI-Scheduler Environment - explains the DI-Scheduler interface 
and menus.

• Chapter 3, Creating and Editing Jobs - describes the DI-Scheduler job creation 
process.

• Chapter 4, DISCH - covers the usage of the disch command-line executable.
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Additional Documentation 1
This manual is intended for users who are already familiar with the Builder, Data Integrator, and 
DiveLine software. Companion manuals are as follows:

• Builder 5.1 - contains more information about creating the Model build description 
files (.dsc) that can be run using DI-Scheduler.

• Data Integrator 5.1 - contains additional information about creating the data 
manipulation scripts (.int) that can be run using DI-Scheduler.

• DiveLine 6.4 - contains additional information about DiveLine server software 
installation and configuration.

• DI-Broadcast 6.4 - contains information about executing DI-Broadcast jobs using 
DI-Scheduler events.

Support 1
Customer support is available from 7:00 AM to 5:00 PM (Central Time).

Diver Solution Licensing 1
Dimensional Insight software is licensed to ensure that only those authorized to use it can do so. 
DI Licensing is by Named Users and applies to production software: DiveLine and its clients, Data 
Integrator, Builder, DiveMaster, and DI-Production, as well as the DI-Diver client (in special 
circumstances). Back-end components require a license key for each system they are to be 
installed on. This license allows for the software to be used in perpetuity. In the server/client 
environment, client license requirements are dictated by DiveLine. When your company purchases 
from Dimensional Insight, the required software licensing will be articulated. For more 
information, please refer to the separate Diver Solution Licensing manual.

Table 1-1: Technical Support Contact Information

Customer Type Phone Fax Email

Domestic Users 920-436-8299 920-433-2378 support@dimins.com

International Users +1-920-436-8299 +1-920-433-2378 international@dimins.com
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Useful Definitions 1
Build description (.dsc) - a DI Object Language file created for the Builder that specifies how 
a Model should be built.

Integrator script (.int) - a DI Object Language file created for the Data Integrator that specifies 
how the data should be manipulated.

Job - As used in this manual, a job is a DI-Scheduler process predefined by the user that builds a 
Model, runs an Integrator script, or posts an Event. DI-Scheduler can run up to ten (10) 
simultaneous jobs.

DI-Scheduler Requirements 1
DI-Scheduler is supported on Microsoft Windows XP SP3, 2003 Server, 2008 Server, 2012 Server, 
7, and 8. The following requirements must be met for DI-Scheduler to run successfully: 

• DiveLine must be running on the server.

• Builder must be installed to run Model builds.

• Data Integrator must be installed to run data manipulation scripts.

DI-Scheduler configuration information can be found below under Configuring DiveLine for use 
with DI-Scheduler.

If the default port 2130 is not being used, you can specify an alternate port 
using the format <servername>:<portnum>. For example, diveline:6400.
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Configuring DiveLine for use with 
DI-Scheduler 1
There are two options for configuring DI-Scheduler: configuration within DI-Config or manual 
configuration. Configuration within DI-Config is the recommended method.

Using DI-Config 1
The DI-Config program installed with DiveLine allows you to configure the DiveLine server for 
DI-Scheduler. Information on using DI-Config can be found in the DiveLine manual. 

1. Locate DI-Config on your system (di-config.exe).

2. Double-click it to launch the software.

3. Enter the DiveLine Server Name to connect to and click Select. If you are not using the 
default port 2130, you can also enter a new port number here, using the format 
<servername>:<portnum>. For example, mydiveline:6400.

4. Enter your administrator Username and Password. 

5. Click OK to connect.
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6. On the General tab of DI-Config, click the Scheduler... button.
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The Scheduler and Broadcast Settings dialog is presented:

7. Enter the DI-Scheduler variables, each of which is described below:

Path to Builder executable - specifies the system path to the command-line 
Builder executable.

Path to Integrator executable - specifies the system path to the Data Integrator 
executable.
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8. Optionally, if you wish to send e-mail alerts from DI-Scheduler (e.g., job failures), enter 
the following DI-Broadcast variables:

Path to Java executable - specifies the system path to the Java executable.

Path to DIAL jar file - specifies the system path to the dial.jar file.

Broadcast from address - specifies the address that DI-Scheduler should use for 
sending e-mail alerts.

Broadcast mail server - specifies the server that DI-Scheduler should send e-mail 
from.

SMTP user name - specifies a valid login user name for the DI-Scheduler server.

SMTP password - specifies a valid login password for the DI-Scheduler mail 
server.

9. Click OK to accept the changes and exit the dialog.

10. Click Save and Exit to commit the changes and exit DI-Config.

11. Create a new directory named security in the \di_solution\dl-dataroot directory.

12. Create two blank files named scheduler-builder and scheduler-integrator in this new 
security directory. Do not give either of the new files a file extension.

13. Restart the DiveLine service according to your installation environment. Refer to the 
DiveLine manual for more information on restarting DiveLine on different platforms.

Performing Manual Configuration Steps 1
The directions below outline the process for configuring the DiveLine server for use with  
DI-Scheduler:

1. Stop the DiveLine service (di-service.exe) according to your installation environment 
(for information specific to your platform, please refer to the DiveLine manual).

2. Open the \dl-dataroot\config\atlcfg.cfg file in a text editor.

3. Copy the following lines into the atlcfg.cfg file:

builder_exe_path=“C:\\<soultion path>\\builder.exe”,

integrator_exe_path=“C:\\<solution path>\\integ.exe”,

java_exe_path=“C:\\<java path>\\java.exe”,

dial_jar_path=“C:\\<solution path>\\dial.jar”,
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broadcast_from_address=“Broadcast@dimins.com”,

broadcast_mail_server=“<mail servername>.<domain>”,

smtp_auth_username= “username”,

smtp_auth_password= “password”,

scheduler_max_simultaneous_jobs=“enter number”,

The optional scheduler_max_simultaneous_jobs parameter restricts the 
number of simultaneous DI-Scheduler jobs that can be run.

4. Modify these lines to work with your system, for example:

builder_exe_path=“C:\DI_Solution\executables\builder.exe”,

5. Save the modified atlcfg.cfg file.

The beginning portion of the modified atlcfg.cfg file should look similar to the sample 
below:

version “1”;

// Computer generated object language file

object 'ACFG' “main” {

auth_scheme=“own”,

security_level=2,

builder_exe_path=“C:\\DI_Solution\\executables\\builder.exe”,

integrator_exe_path=“C:\\DI_Solution\\executables\\integ.exe”,

java_exe_path=“C:\\Program Files\\java\\jdk1.6.0_14\\bin\\java.exe”,

dial_jar_path=“C:\\DI_Solution\\executables\\dial.jar”,

broadcast_from_address=“Broadcast@dimins.com”,

broadcast_mail_server=“mail.domain.com”,

smtp_auth_username= “username“,

smtp_auth_password= “password”,

scheduler_max_simultaneous_jobs=“enter number”,

maxusers=100,
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Although not required to use DI-Scheduler, the broadcast_from_address, 
broadcast_mail_server, smtp_auth_username, and smtp_auth_password 
lines are necessary if you want DI-Scheduler to send e-mail alerts.

6. Create a new directory named security in the \DI_Solution\dl-dataroot directory.

7. Create two blank files named scheduler-builder and scheduler-integrator in this new 
security directory. Do not give either of the new files a file extension.

8. Restart the DiveLine Service (di-service.exe).
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Starting DI-Scheduler

You must be an administrative user in DiveLine to log in to DI-Scheduler. To start using 
DI-Scheduler:

1. Locate and double-click the scheduler.exe file.

2. From the Open File - Security Warning dialog, verify DI is the publisher, and then click 
Run.

3. You will be prompted to enter the DiveLine Server to connect to, as shown below. Enter 
a Server Name and port number (if the default port 2130 is not being used), and click 
Select.

4. Enter your DiveLine Username and Password and click OK to connect.

Do not run DiveLine as a local system (localhost) if DI-Scheduler will be 
running Data Integrator scripts with ODBC or FTP commands.
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Log Files 1
When a job is executed in DI-Scheduler, the atljobs.cfg file is updated with execution information. 
Information for a job can accumulate over time—that is, DI-Scheduler keeps information for the 
most recent runs up to the max_occurrences number. See Number of logs to keep on page 3-26.

The atljobs.cfg file is stored in the \DI_Solution\dl-dataroot\config\ directory. Look for 
atljobs.xxxx.cfg, where xxxx is the port number—for example, atljobs.2130.cfg. A backup of the 
atljobs.cfg file (atljobs.xxxx.cfg.bak) also appears in this folder. Shown below is an excerpt from 
a Job List object in a typical altjobs.cfg file:
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Note the filename attribute that points to a log file stored in \DI_Solution\dl-dataroot\temp. This 
file is called scheduler<yyyymmdd>.<port>.log. DI-Scheduler produces one log file per day, with 
a maximum size of 16 MB. The log file describes the status of all jobs on the date in the log file 
name (October 4, 2013 in the file named above). These daily activity logs show job additions, 
executions, and output. 

Troubleshooting DI-Scheduler 1
When running a DI-Scheduler job, if you receive the following error message:

“Action failed: The 'Integrator' Scheduler action is disabled for security reasons. This 
action can be enabled by the server administrator. [Error Number 100206] 
(jobprocess.c:991)”

please review your configuration steps to verify that the configuration is correct.

Also, if the atljobs.cfg file becomes corrupted, it can be replaced with the backup file. Open the 
backup file (extension .bak) to make sure it is not corrupt, and then resave it without the .bak 
extension.
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The DI-Scheduler 
Environment 2

This chapter describes the interface used to create and maintain DI-Scheduler jobs. It includes a 
description of the main DI-Scheduler dialog and details each DI-Scheduler menu item.

The DI-Scheduler Startup Dialog 2
At startup, the main DI-Scheduler dialog shown below is displayed. An explanation of each area 
of the main dialog and each menu follows.
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Connected to/as 2
This area displays the name of the DiveLine server that you are connected to, as well as the 
username you are connected as.

Server Time 2
The Server Time displays the current time on the DiveLine server that you are connected to. The 
time is given in the format hh:mm:ss AM/PM.

Name 2
The Name column shows the names of the DI-Scheduler jobs that are currently configured. This 
list will include all of the currently configured jobs, or only the jobs for the currently logged on 
user, depending on whether “All jobs” or “My jobs only” has been selected from the View menu. 
The default selection is “My jobs only”.

Type 2
This column specifies the type of schedule being followed by the named job. Schedule types 
include Hourly, Daily, Weekly, Monthly, Yearly, Once, Event, and Never, each of which is 
explained in detail in Chapter 3, Creating and Editing Jobs.

Owner 2
The Owner column lists the named user the job belongs to. The Owner column is only displayed 
when the “All Jobs” option is selected from the View menu.

Last Run 2
This column lists the date and time the job was last executed successfully. The date is given in the 
format yyyy/mm/dd and the time in the format hh:mm:ss (24-hour clock).

Next Run 2
This column lists the date and time the named job is scheduled to run. The date is given in the 
format yyyy/mm/dd and the time in the format hh:mm:ss (24-hour clock).



The DI-Scheduler Startup Dialog

The DI-Scheduler Environment 2-3

DI-SCHEDULER

New 2
The New button opens the New Job dialog, allowing you to create a new DI-Scheduler job.

Edit/Examine 2
The Edit button opens the Edit Job dialog, allowing you to change the configuration of the 
currently highlighted job.

When a job is locked, “Edit” becomes “Examine”. When Examine is displayed, the job can be 
opened and viewed, but changes cannot be made. A job is locked when another user already has 
that job open in Edit mode in a different DI-Scheduler connection or when the job is running.

Delete 2
The Delete button permanently removes the currently highlighted job from DI-Scheduler.
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Menus 2
DI-Scheduler has the following menus to assist you in server connection, job creation, and job 
maintenance:

• Connection Menu

• Jobs Menu

• Events Menu

• View Menu

• Help Menu

Each menu item is described in the following sections.

Connection Menu 2
The Connection menu allows you to specify the DiveLine server you are connecting to or exit the 
software.

Select Server... 2
The Select Server menu item allows you to choose another server to connect to. You will be asked 
to commit any job changes made before the connection is switched.

Exit 2
This menu option closes DI-Scheduler. You will be asked to commit any job changes made before 
exiting.
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Jobs Menu 2
The Jobs menu provides options needed to create, edit, run, review, and remove jobs in 
DI-Scheduler.

New job... 2
The New job option opens a dialog allowing you to configure a new DI-Scheduler job. See 
Chapter 3, Creating and Editing Jobs for detailed information on new job configuration.

Edit/Examine job... 2
The Edit job option allows a user to open a previously configured job and change or update its 
current settings.

When a job is locked, “Edit job...” becomes “Examine job...”. When Examine job is displayed, 
the job can be opened and viewed, but changes cannot be made. A job is locked when another user 
already has that job open in Edit mode in a different DI-Scheduler connection or when the job is 
running.

Delete job... 2
Delete job allows you to remove the currently selected job from DI-Scheduler. You will be 
presented with the Delete confirmation dialog. Once you confirm the deletion, the job will be 
removed permanently. If the job is needed later, it has to be recreated.

Copy job... 2
Copy job allows you to copy all of the properties of the currently selected job. When this menu 
item is selected, it launches the New Job dialog with all properties of the copied job already set.
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Environment Variables... 2
The Environment Variables option lets you pass variables to DI-Scheduler jobs, allowing 
Integrator scripts to pull in these variables specific to DI-Scheduler jobs, but not the entire 
operating system. For example:

1. Start DI-Scheduler.

2. Select Jobs > Environment Variables.

3. Click New.

4. In the Name field, type a variable name, e.g. “my_variable”.

5. In the Value field, type the correct value, e.g. “my_value”.

6. Click OK twice.

7. Create a DI-Scheduler job that will make use of this new environment variable. For this 
example, schedule a job to run an Integrator script that includes the following parameter 
object:

object 'PARM' “parms” { parms = { { name=“my_variable”, 
default=“some_other_value”, type=“string”, environment=“true” } } };
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Later in the script, there is a line that makes use of this parameter:

filename = `env_var_test_$my_variable.txt`,

When this Integrator script is run through DI-Scheduler, the filename resolves to:

env_var_test_my_value.txt

When run outside of DI-Scheduler without using a parameter, the filename resolves to:

env_var_test_some_other_value.txt

Execute job... 2
Execute job allows you to run the currently selected job. You will be presented with the Execute 
confirmation dialog shown below:

Once you select “Yes”, the job will run immediately.

Cancel job... 2
Cancel job allows you to stop any job that is currently running.
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Review job history... 2
Select Review job history to open the dialog below, allowing you to review the success or failure 
of attempted runs of the selected job.

The Job History dialog only displays the last eight job run attempts. There is no scroll bar for the 
display of additional history.

Job Name 2

The Job Name area shows the name of the job being reviewed.

Last “x” runs 2

The Last “x” runs line specifies the number of run attempts being shown in the Job History 
dialog.

Start Time 2

Start Time displays the date and time when the job began. The date is displayed in yyyy/mm/dd 
format and the time is displayed in hh:mm:ss format.

Why Begun 2

The Why Begun column shows what triggered the job to run.

Why Ended 2

The Why Ended column shows that a job finished successfully or, if a failure occurred, why it 
failed.
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Details... 2

The Details button will be active if the job has failed for any reason. Select this option to open the 
Job Occurrence Details dialog shown below:

In this example, the Sales Build job failed because the build description file could not be opened.

Close 2

The Close button exits the Job History dialog and returns to the main DI-Scheduler interface.

Save Job Report... 2
Save Job Report allows you to save a simple, tab-delimited text file with the contents of the job 
table. Depending on your needs, the report can be loaded into Excel for formatting or manipulated 
by the Data Integrator.
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Events Menu 2
The Events menu allows you to create, manage, and execute DI-Scheduler trigger events.

Manage event list... 2
The Manage event list menu item opens the Events dialog shown below:

This dialog shows a list of all abstract triggers, called events, that have been defined in either 
DI-Broadcast or DI-Scheduler. It also allows you to create a new event. An event is a flag that tells 
DI-Broadcast or DI-Scheduler to start a job based on the occurrence of the specified event. It is 
important to note that a job can only wait for one event. The event can be triggered manually, from 
a batch file, or by posting an event. More information about using events in a job can be found 
under Event on page 3-10 and Event Settings on page 3-18.

New 2

Click New to open the New Event dialog, allowing you to specify the name of the new event. Enter 
the desired name, and click OK to accept the name or Cancel to return to the Events dialog. 
Multiple events created by the same user cannot have the same name.



Menus

The DI-Scheduler Environment 2-11

DI-SCHEDULER

Execute 2

Execute allows you to manually trigger the selected event.

Delete 2

Delete removes the selected event from the list.

OK 2

OK closes the Events dialog.

View Menu 2
The View menu allows you to view jobs created in DI-Broadcast and DI-Scheduler.

All jobs 2
When selected, the All jobs menu option displays all defined jobs in both DI-Broadcast and 
DI-Scheduler. In the example below, Sales Build is a DI-Scheduler job and Sales Marker is a 
DI-Broadcast job.

Scheduler jobs 2
The Scheduler jobs menu option displays only those jobs created in DI-Scheduler. Notice below 
that when “Scheduler jobs” is selected, the Owner column is not present.
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Help Menu 2
The Help menu provides information about the DI-Scheduler software.

About DI-Scheduler 2
The About DI-Scheduler dialog displays the version of DI-Scheduler in use, the DiveLine 
version, server name, and port number, the type of user that is connecting (admin or non-admin), 
and which DI-Broadcast and DI-Scheduler capabilities have been configured on the DiveLine 
server.

When fully scrolled, the text in the About DI-Scheduler dialog appears as follows:
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DI-Scheduler is used to control the flow and execution of Data Integrator and Builder scripts used 
to prepare the backend Model files that support the front end DI-Clients such as ProDiver and 
DivePort. Typical usage is to break the flow into three jobs:

• Data Extraction job(s)

• Data Transformation job(s)

• Data Load job(s)

Business constraints for your environment may require you to expand this basic profile into 
something much more complex. DI-Scheduler supports more complex logic and flow by 
employing flexible scheduling along with triggering and wait events.

Creating a new job in DI-Scheduler is a simple process described in the paragraphs that follow. To 
begin creating a new job, go to Jobs > New job... or click New in the main DI-Scheduler interface 
to open the New Job dialog. DI-Scheduler can have up to ten simultaneous jobs at a time. If more 
are scheduled for the exact time, the eleventh will wait until one finishes, and so on. The Edit Job 
dialog mirrors the New Job dialog described below.
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General Tab 3
The first area displayed in the New Job dialog is the General tab shown below:

Job Name 3
Enter the name of the job being created on the Job Name line. Give the job a name that is related 
to the job’s purpose—for example, “Sales Build” or “Month-to-Date Build”. Job names are limited 
to 64 characters.

Comment 3
The Comment area can be used to enter additional information about the job. For example, if the 
name of a job is “Sales Build”, the Comment line might say “Nightly Sales Model Build process” 
to further describe the job being created.

Last Run 3
The Last Run line lists when the job ran last. When creating a new job, this line will say “None”. 
When editing a job, it will give the date and time of the last run in yyyy/mm/dd and hh:mm:ss 
formats.
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OK 3
When you have finished configuring or editing a job, click OK to save the changes or newly 
created job and close the New Job dialog.

Cancel 3
Cancel closes the New Job dialog without saving the new or edited DI-Scheduler job.
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Schedule Tab 3
The second area of the New Job dialog is the Schedule tab. The appearance of this tab varies, 
depending on the Schedule Type chosen.

Type 3
The Type area of the Schedule tab allows you to specify how frequently a job should be run. 
Options are as follows:

Hourly 3
When the Hourly option is selected, you can specify the minute past the hour that the job should 
run and a window of time in which the job should run. For example, if the job should run at fifteen 
minutes past every hour for one week starting on June 4th, 2012, you would enter or select 15 in 
the Every hour at box, Jun 4, 2012 in the From box, and Jun 10, 2012 in the Until box. This 
option is useful when building incremental Models throughout the course of the day.
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Daily 3
The Daily option allows you to specify the hour of the day that the job should run, by entering or 
selecting the desired hour from the Every day at box, when the job should begin running (From), 
and how long it should run for (Indefinitely or Until). This option is useful when running daily 
Data Integrator scripts or building a daily Model.
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Weekly 3
The Weekly schedule type allows you to select a specific day of the week to run the job on, a 
specific time of day to run the job (at), when the job should begin running (From), and how long 
it should run for (Indefinitely or Until). This option may be used to build a weekly sales Model on 
the weekend.
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Monthly 3
A Monthly schedule allows you to select either a specific day of the month or the first day of the 
month, the time of day that a job should run (at), when the job should begin running (From), and 
how long it should run for (Indefinitely or Until). Monthly jobs are commonly used for Monthly 
Model builds, such as a Month-End Model.



3-8 Creating and Editing Jobs

Schedule Tab

DI-SCHEDULER

A Yearly schedule allows you to execute a job once per year on the specified day or days, starting 
at the specified time and running Indefinitely or Until a given end date. A Yearly schedule might 
be used to run scripts and build Models containing Year-End or Quarter-End data.

To create a job that runs quarterly, use the Yearly type and schedule the job on the day after each 
quarter end. For example:
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Once 3
Running a job using the Once schedule type allows you to specify the date and time at which to 
run a non-recurring job. This option is useful for special one-time jobs, such as running a script that 
queries the version numbers of all currently installed DI software.
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Event 3
The Event option allows you to specify that a job should only run if the highlighted event occurs. 
A specific event must be configured in the Events dialog prior to using this option. For further 
information on creating and using events, refer to Events Menu on page 2-10 and Event Settings 
on page 3-18.

A DI-Scheduler job can be only be set to execute based on one event. If you want to have a job 
execute based on multiple events—e.g., after 5 simultaneous jobs have completed—you need to 
post one event and create 4 unique files. The subsequent job is set to execute on the one event, but 
also wait for the 4 files to exist.
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Never 3
The Never schedule option allows you to create a job that can only be manually executed. This 
option is most often used in a test environment to ensure that a job can run correctly.
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Other 3
The Other option allows you to schedule the job at the specified minute interval. The options are 
1, 5, 10, 15, 20, or 30 minutes. This option is commonly used for incremental builds that need to 
run every 15 minutes. This option can also be used in combination with the “Wait for File to Exist” 
action to trigger the execution of a job whenever a file exits.

OK 3
When you have finished configuring or editing a job, click OK to save the changes or newly 
created job and close the New Job dialog.

Cancel 3
Cancel closes the New Job dialog without saving the new or edited DI-Scheduler job.
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Actions Tab 3
The New Job dialog Actions tab displays the list of actions to be taken in a particular job. In the 
example below, the job will run a nightly build script and post an event. Actions configured 
without event triggers will run sequentially, in the order in which they are listed. If a parent action 
fails, child actions will not run. Steps for creating different actions can be found in the General 
Tab section on the next page.

Up 3
The Up button allows you to move the selected action up in the list.

Down 3
The Down button allows you to move the selected action down in the list.

New 3
The New button allows you to create a new action.
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Edit 3
The Edit button opens the Edit Action dialog for the selected action, allowing you to make 
changes to a previously configured action.

Delete 3
The Delete button allows you to delete the selected action in the Actions tab.

General Tab 3
When New is selected in the New Job dialog’s Actions tab, the following New Action dialog is 
displayed. The General tab information is described below.

Action Name 3

Specifies the name that describes the action being configured. For example, when scheduling a 
Model build, the Action Name might say “Sales Model Build”.

Action Type 3

The Action Type pulldown gives you the option to choose from one of five actions. These include 
Run Builder Script, Run Integrator Script, Post Event, Wait for File to Exist, and Sleep.
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Run Builder Script 3

This Action Type allows you to schedule a Model build and pass along arguments.

Run Integrator Script 3

The Run Integrator Script action allows you to schedule the execution of a specified Data 
Integrator script. Parameter values can be passed to the script.

Post Event 3

Post Event allows you to trigger other actions based on the occurrence of a specific, previously 
configured event. More information on creating and using events can be found under Events 
Menu on page 2-10 and Event Settings on page 3-18.

Wait for File to Exist 3

The Wait for File to Exist check box allows you to schedule a job based on the existence of a 
specific file. Use this feature to create more complex process flows.

Sleep 3

Sleep allows you to pause a job for a specified amount of time.

Settings Tab 3
The New Action dialog’s Settings tab varies, depending on the type of action selected from the 
Action Type pulldown. 

• For Run Builder Script, the tab is labeled “Builder Settings”. See Builder Settings on 
page 3-16.

• For Run Integrator Script, the tab is labeled “Integrator Settings”. See Integrator 
Settings on page 3-17.

• For Post Event, the tab is labeled “Event Settings”. See Event Settings on page 3-18.

• For Wait for File to Exist, the tab is labeled “File Settings”. See File Settings on page 
3-23.

• For Sleep, the tab is labeled “Sleep Settings”. See Sleep Settings on page 3-24.
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Builder Settings 3

The Builder Settings tab allows you to configure the Builder job to be executed.

Build Script 3

The Build Script line accepts the full path to the Build description you wish to run.

Builder Arguments 3

The Builder Arguments area allows you to specify additional Builder variables that should be 
used when executing the build script. For example, entering -first 1000 would build using only the 
first 1000 rows of data in the Builder script input file; entering -define dir=”d:/di_sales/data” 
would pass the value for the dir parameter.
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Integrator Settings 3

The Integrator Settings tab allows you to configure the Data Integrator script to be executed.

Integrator Script 3

The Integrator Script line accepts the full path to the Data Integrator script you wish to run. 
Typical usage is to have this target script execute one or more Data Integrator programs that are 
related in some way—for example, a sequence of data extraction scripts.

Integrator Arguments 3

The Integrator Arguments area allows you to specify additional Integrator variables that can be 
used when executing the script. For example, entering -first 1000 would limit the output to only 
1000 rows of data.
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Event Settings 3

The Event Settings tab allows you to define event triggers to be used in DI-Scheduler jobs.

Event 3

The Event area displays a list of previously created events that you can select from. See Events 
Menu on page 2-10 for information on creating events.

Using Events 3

Events can be used in DI-Scheduler in simple or complex ways. An event can be used to trigger 
another single job, such as a Model Build or a DI-Broadcast job, or it can be used in combination 
with other features, such as the “Wait for file to exist” feature, to trigger several jobs that in turn 
contain events that trigger other jobs. The examples below provide a simple scenario for using an 
event in DI-Scheduler and DI-Broadcast.
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Scenario 1 - Using an Event to trigger another DI-Scheduler job

I have a DI-Scheduler job that runs an Integrator script (“Job A”). After the script is run, I want a 
second DI-Scheduler Model build job (“Job B”) to automatically run. How can I use events to do 
this?

Part A - Create a new event

1. Go to Events > Manage Event List...

2. Click New.

3. Enter “Job A Finished” as the event name.

4. Click OK.

Part B - Create the Integrator job and job actions (“Job A”)

1. With DI-Scheduler still open, go to Jobs > New Job...

2. On the General tab, enter “Integ Script” on the Job name line.

3. Select the desired schedule on the Schedule tab.

4. On the Actions tab, click New.

5. For Action Name, type “Job A”.

6. For Action Type, select Run Integrator Script.

7. On the Integrator Settings tab, enter the path to the desired .int file.

8. Click OK to create the new action.

Part C - Add the event to the job

1. With the New Job dialog still open, click New on the Actions tab again.

2. For Action name enter “Job A Finished”.

3. For Action Type, select Post Event.

4. On the Event Settings tab, highlight “Job A Finished” (created in Part A above) and 
click OK.

You now have two actions on the Actions tab of the job that you are creating: an 
Integrator script action called “Job A”, and an event action called “Job A Finished”.
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5. Click OK to close the New Job dialog.

Part D - Use the event (“Job A Finished”) to trigger another job (“Job B”)

1. With DI-Scheduler still open, go to Jobs > New Job...

2. On the General tab, enter “Model Build” on the Job name line.

3. Select Event on the Schedule tab.

Event will always be used when triggering a job.

4. Highlight “Job A Finished” in the On the following event text box.

5. On the Actions tab, click New.

6. For Action Name, type “Job B”.

7. For Action Type, select Run Builder Script.

8. On the Builder Settings tab, enter the path to the desired build description file.

9. Click OK to create the new build action.

You now have a DI-Scheduler Model build job, “Job B”, that is scheduled to run any 
time the job “Job A” is finished and the event “Job A finished” is posted.

Some implementations of The Diver Solution will have multiple DiveLines 
running on the same server. In such cases, DI-Scheduler events created on 
one DiveLine will not affect jobs created on a different DiveLine.  
 
Each DiveLine instance stores its list of possible events in an atljobs.cfg file 
that is tied to its port number, e.g.: 
 
dl-dataroot/config/atljobs.2135.cfg 
 
When an event is run, only the appropriate DiveLine can "listen” to that 
event and initiate the relevant job.



Actions Tab

Creating and Editing Jobs 3-21

DI-SCHEDULER

Scenario 2 - Using an Event to trigger a DI-Broadcast job

I have a DI-Scheduler job that runs a Sales Model build job (“Job A”). After the build is complete, 
I want a DI-Broadcast e-mail job (“Sales Marker E-mail”) to automatically run. How can I use 
events to do this?

Part A - Create a new event

1. Go to Events > Manage Event List...

2. Click New.

3. Enter “Job A Finished” as the event name.

4. Click OK.

Part B - Create the Build job and job actions (“Job A”)

1. With DI-Scheduler still open, go to Jobs > New Job...

2. On the General tab, enter “Sales Model Build” on the Job name line.

3. Select the desired schedule on the Schedule tab.

4. On the Actions tab, click New.

5. For Action Name, type “Job A”.

6. For Action Type, select Run Builder Script.

7. On the Builder Settings tab, enter the path to the desired build description file.

8. Click OK to create the new build action.

Part C - Add the event to the job

1. With the New Job dialog still open, click New on the Actions tab again.

2. For Action Name enter “Job A Finished”.

3. For Action Type, select Post Event.

4. On the Event Settings tab, highlight “Job A Finished” (created in Part A above) and 
click OK.

You now have two actions on the Actions tab of the job that you are creating: a Model 
build action called “Job A”, and an Event action called “Job A Finished”.

5. Click OK to close the New Job dialog.
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Part D - Use the event (“Job A Finished”) to trigger a DI-Broadcast job (“Sales Marker 
E-mail”)

1. Open DI-Broadcast.

2. Go to Jobs > New Job.

3. On the General tab, name the new Job “Sales Marker E-mail”.

4. On the Schedule tab, select Event as the type of schedule 

Event will always be used when triggering a job.

5. Highlight “Job A Finished” in the On the following event text box.

6. Click the Marker Settings tab.

7. Browse to any Marker that uses the Model that is being built in your scheduled Build 
job, created in Part B above. 

8. Select any Attachment file type.

9. Select the Email Settings tab, enter the e-mail addresses of the intended recipients in the 
To:, Cc:, and Bcc: lines.

10. Enter the desired subject and message text.

11. Click OK.

You now have a DI-Broadcast job, “Sales Marker E-mail”, that is scheduled to run any 
time the job “Job A” is finished and the event “Job A finished” is posted.
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File Settings 3

If a job is to wait for a file to appear, you need to specify the location on the File Settings tab.

File 3

Specifies the system path to the file that needs to exist for the defined Wait for File to Exist action. 
The job then waits for this file. It can be used as a “trigger” in two ways:

• Job executes when the file appears (use only the Wait for File to Exist action).

• Job starts at particular time then waits for the file to appear (schedule Daily at a 
particular time and also configure the Wait for File to Exist action).
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Sleep Settings 3

The Sleep Setting tab allows you to specify a length of time to pause the process.

Delay (in seconds)

The Delay (in seconds) box allows you to enter the number of seconds to pause the job. After the 
specified duration has elapsed, the job will resume with the next step in the Actions list.

OK 3
When you have finished configuring or editing a job, click OK to save the changes or newly 
created job and close the New Job dialog.

Cancel 3
Cancel closes the New Job dialog without saving the new or edited DI-Scheduler job.
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Advanced Tab 3
The Advanced tab allows you to specify additional execution requirements for the job being 
created.

Wait for file to exist 3
The Wait for file to exist check box is a legacy option used for backward compatibility. A better 
practice is to use the action type instead. See Wait for File to Exist on page 3-15.

Send error reports to 3
This option allows you to send error reports from a job to the specified e-mail address(es). Multiple 
addresses should be comma-separated.

Automatically abort the job after 3
This check box allows you to tell DI-Scheduler to stop executing a job after “x” number of hours. 
This is recommended if you are using the Action Type “Wait for file to exist”. Be sure the wait time 
is longer than the job execution.
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Number of logs to keep 3
This option sets the number of historical job runs to keep. DI-Scheduler keeps the most recent runs 
up to this number. The default is 8. A value of 0 (zero) will keep all runs (not suggested).

OK 3
When you have finished configuring or editing a job, click OK to save the changes or newly 
created job and close the New Job dialog.

Cancel 3
Cancel closes the New Job dialog without saving the new or edited DI-Scheduler job.
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The executable disch.exe is the command-line version of DI-Scheduler. The options listed and 
described below are available from a command-line window.

Connecting to DiveLine 4

Informational Options 4

Table 4-1: disch DiveLine Connection Options

Command Description

-server <servername>:<port> Specifies the DiveLine server and port to connect to.

-login <username> <pass-
word>

Specifies the DiveLine username and password to connect 
with.

Table 4-2: disch Informational Options

Command Description

-help Displays disch.exe usage information.

-version Displays the disch.exe version information.
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Commands 4

Several -commands require the “owner”. To see the owner in DI-Scheduler (GUI), select View > 
All jobs.

The “-postevent” command requires that the event to be posted is already defined in DI-Scheduler. 
To create an event see Event Settings on page 3-18.

Examples 4
The following examples show proper disch.exe syntax:

disch -server diveline:2135 -login admin admin -executejob 
admin job1

If any parameter or event name contains spaces, then that value must be enclosed in quotes.

For example, to execute a job named “data extract”:

disch -server diveline -login admin admin -executejob admin 
“data extract”

Table 4-3: disch Commands

-listevents Lists all available events.

-listjobs Lists all available jobs.

-postevent <owner><event> Posts the specified event.

-executejob <owner><job> Executes the specified job.

-showactivity Tells DI-Scheduler to stay connected to DiveLine and show 
all DI-Scheduler activity.
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